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Overview   

Understanding Movie Formats 
Before you can begin the process of converting VHS to digital video, you must decide 
what movie format you need, based on how the clip will be used.  Do you want a file for 
PowerPoint presentations?  Do you want to make streaming clips for the Internet?   Do 
you want to create a DVD that can be played on a home DVD player?   Your answer will 
determine the settings used to capture your video. You cannot create a single ‘all 
purpose’ DVD clip that works in all of these environments.  Often, you must create 
separate types of clips for each intended use. The chart below lists the preferred file 
format for each application: 
 
Final Application Preferred File Format Media Player Used 
PowerPoint on PC .avi  Windows Media Player 

(embedded in PowerPoint)* 
Play on any PC .avi or .mpeg1 Windows Media Player 
Streaming over Internet .wmv (also, .mov and .rm) Windows Media Player (also 

Quicktime and Real Player) 
Home DVD Player .mpeg2 DVD Equipment 
Video CD or VCD NA - Not recommended NA – Not recommended 
Tape .dv Digital Camcorder 

 

Permissions and Copyright 
If you will be using the clip in class, you must also determine if you have permission to 
use the video.  Check the University of Texas Crash Course in Copyright for the specifics 
on digitizing video clips for use in the classroom.  Here is the web address: 
http://www.utsystem.edu/ogc/Intellectualproperty/cprtindx.htm 
 
 
Digital video is very resource intensive.  In order to create and edit digital video, you 
must have a computer that has lots of speed and lots of memory.  If your movie stutters 
when playing back, it may not have enough speed or memory to process the video.  In 
addition, video clips take an enormous amount of storage space.  Plan on purchasing an 
external harddrive with gigabytes of storage space if you are going to be working with 
digital video.   
 
In addition, digital video production, like all video production, can take many hours to 
complete.  Schedule several hours of time for each session and save your work often as 
you go. 
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Using Pinnacle Studio 
Creating digital video clips from VHS is a three step process in Pinnacle.  You must: 

1. Capture original video source to computer 
2. Edit the video by adding fades, black, etc. 
3. Make movie.  Several different movie formats are available. 

 
When you open Pinnacle Studio, you will see three tabs that represent each of the three 
basic steps.  Select Capture. 

 
 

 
Step One:  Capturing Video from a Digital Camera   
Now, connect your camera to Pinnacle, either via the board inserting into your desktop 
PC or via the external Pinnacle connection hub.  You will need the proper cable to 
connect the two.  Turn on the camera.  Open the Pinnacle Studio software and then open 
up the Capture Source menu. 
 
Capture Source Settings 
Click on the Settings button, click on Capture Source and make sure the dropdown 
menu is set to your camera model.  You also want it set to NTSC (American TV) and 4:3 
Aspect Ratio (regular TV, not widescreen). 

 
 
 
 

Capture Source 
 Is set to camera 

 
 
 
 

  
Scene Detection  

 
Capture Source Menu 

 
You can select how you want your video clips segmented using the Scene Detection 
menu.  Pinnacle can either create one long video clip by capturing your entire video all at 
once or allow you to break it up into segments or clips.  We recommend you capture 
segments.  Not only is it a safer import process technically, it makes editing easier later.   
For example, you might have recorded many students delivering speeches for a class.  If 
you choose to detect scenes automatically, your video clips will be captured in 
segments – one speech per clip.  The overall movie will play seamlessly no matter how 
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many clips you have, but it will be easier to edit the movie if you capture automatically 
by scene (e.g., new speaker in your video).   Otherwise, you can choose to capture clips 
based on specific time (e.g., every 30 seconds, etc.).   After selecting, click OK. 
 
If the camera is connected properly, you will see an image of a camcorder. 

 
Capture Menu 

 
Make sure you have DV Capture selected.    Click on the Capture Directory Folder  
(where it says Drive(C) above) to specify the location where you want to store the 
captured files.  If in doubt, use the default folder set up by Pinnacle during installation. 

 
You are ready to start capturing your video clips.  Cue up your video on your camera and  
test your capture.  Capture a short clip, and play it back to make sure you have both 
video and audio.  To start your capture, click on the Start Capture.  A window will open, 
prompting you to name the clip you are about to capture.  Be sure to name it something 
you will recognize later. 

 
Click on the Start Capture button.  Each time you stop and start a new capture, you start 
a new clip, which will have to be named.   
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Click on the Edit Tab when you are finished.    
 

 
Your video clips have been captured into the video album. 

 
                                  Captured Video Clips in the Album 

Step Two:  Editing your Movie 
Now you are ready to start building and editing your movie.  To edit your movie, you 
will drag your video clips onto the timeline, and then edit the movie there.  You can 
delete clips, combine them, add black or titles – even boost the audio - just like you do in 
word processing, only using clips rather than text. 
 
To begin, you will build a rough cut using the storyboard.  Be sure you are in the Edit 
Storyboard view.                

                                                   
 
                                                              Changing to Storyboard View 
 
Left-click and drag clips down to your storyboard frames in chronological order.  Today, 
we have twenty or so clips.  Although you could drag them down one at a time, it makes 
sense to select them all and then drag them down.    

 
1. Click on the first clip in the Album. 
2. Select Ctrl A on your keyboard to highlight all the clips in the Album. 
3. While they are all selected, drag all clips down to the timeline. 
4. Save your movie project using the Save As in the File menu.  Save often!!! 

You will now see your clips in the timeline. 

 
Clips in the Storyboard 
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Now you will want to see a more detailed view of your movie.  Change to the Timeline 
view.                

                                                   
 
                                                                      Changing to Storyboard View 
 
The timeline is divided into parallel tracks and each track ‘holds’ one element of your 
movie as shown below.   You will build your movie by dragging these elements on to the 
timeline.      
 

 
  Video/Audio 
   Toolboxes 
 

        Video Track 
 

Original Audio      
         Track 
 
Still Picture Track 
 

Voiceover Track 
   
 
Titles Track 

          
Sound Effects Track 

 
Music Track  

 
Movie Timeline View 

 
Playing your Movie 
You can play your video by hitting the space bar on your keyboard.  Hitting the spacebar 
again will stop playback.   You can increase or decrease the amount of time displayed in 
the timeline to see more or less of the movie by using the zoom tools in the lower left 
hand corner of the timeline (near the music track).  Use the scroll bar to move lengthwise 
along your movie timeline. 
 

 
Timeline Zoom Tools 

 
TIP:  Left click twice in the preview screen to play a clip back at full screen. 
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Basic Editing 
The beauty of video editing is that it works much like word processing.  You can hold-
click and drag clips to rearrange your clips on the timeline.  You can highlight one clip, 
and then delete it with your delete key. 
 

There are three basic ways to edit video clips.  You can: 
1. Split or edit a clip while it is still in the Album. 
2. Split or delete a clip on the timeline. 
3. Trim a clip using the Clip Properties Tool. 

 
It is possible to split up a clip while it is still in the Album.  Right click on the clip in the 
album and it will bring up the Scene Detection menu.  This is useful if you did not use 
automatic scene detection during capture, but have changed your mind. 
 
To split a clip easily, drag it to the timeline. Place the playback head at the location where 
you wish to make a split, and then left click on the razor blade tool.  This splits the clip. 
 

 
Split Clips Button 

 
 
You can use this same technique to delete a section of video in the middle of a clip.  First, 
place the playback head at the beginning of the material you wish to cut.  Left click on 
the razor blade to split the clip.  Next, find the ending point of the material you wish to 
cut and split the clip there as well.  Now, left click to highlight the section you wish 
deleted and delete it using the delete key on the keyboard.  This does not affect the 
original clip (still in the clips album). 
 
 
The beginning of our movie has some bad video footage in the beginning that we don’t 
need.  We will delete it.       

1. First, place the playback head at the beginning of the section you wish to cut.   
Note:  You can stop playback by hitting the space bar.       

2. Left click on the razor blade to split the clip.    It will split the clip right where 
the playback head was.   

3. Play the movie until it reaches the end of the ‘bad’ video footage and then left 
click on the razor blade to split the clip.    Now we need to select the clip we 
wish to cut. 

4. Left click to highlight the clip containing the portion we want to delete. 
5. Delete it using the delete key on the keyboard.  This does not affect the original 

clip (still in the clips Album). 
6. Save your project. 
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If you wish to trim the end of a clip, you can also use the Modify Clip Properties Tool.  
Under the Toolbox menu, select Modify Clip Properties Tool.    
 

Use the sliding razors or ‘trimmer scrubs’ on each end to trim either end of the clip.  Use 
the menus on the side to add titles, add effects, etc. to the clip. 
 
Adding other Editing Effects  
You can add sounds, special effects and titles easily using the Editing Menu Tabs.   
 

 

 
The Album 
 
Transitions 
 
Titles 
 
Photo/Frame Grab 
 
DVD Menu 
 
Sound Effects 
 
Music 

 
 
You can add titles, sound effects, narration, and 
even special effects.  All of these work in a drag 
and drop process.  All the menus for these various 
editing tools are selected from a horizontal panel 
of tabs. 
 
Remember, the album holds all your captured 
clips. 
 
 
 
 

Editing Menu Tabs 

Click on the specific tab you need.   Each one contains a library.  Place your playback 
head where you wish to add the effect.  Select the effect, sound, title, etc. that you wish to 
use and drag it to your timeline.   
 
Transitions – Use this to add transitions between your clips, such as fading, etc.  
Titles – Use this to superimpose titles at the beginning, end, or between clips. 
Photo/Frame Grab – Use this to add pictures.  You can also ‘grab’ a picture from your move 
and save it as a picture. 
DVD Menu – If you are making a DVD, use this to add a DVD chapter menu. 
Sound Effects – Use this to add special sounds effects such as barking, roosters, etc. 
Music – Use this to add ‘music under’, a second track of audio underneath narration. 

 
 

Trim Clip 
Add Title 
Edit Disc 

Grab a Frame (photo) 
Create Music Video 

Add Effect 
 

Trimmer scrub 
 

 
                                        Modify Clip Properties Tool 
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Adding a Transition  

 
Adding Titles  
 
It is also tradition to add beginning and ending titles…especially beginning titles.   

• Open the Titles tab.   
• Select the title on page one which says “Happy Holidays”. 
• Left click the title and drag it to your timeline, inserting it between your first 

clip and your fade transition.   
 

Most of the choices are for home videos and not very ‘academic’, so we probably want 
to edit it.  To do so:   

• Double-click on your title in the timeline and an editing menu will open up.  
This editing menu works in much the same way that word processing does.  
You can change font, font size and even move the text boxes around on the 
screen.  Edit your graphic to replace wording and styles. 

• Click OK. 
• Play the beginning of your movie. 
• If you like the way it looks, Save your movie project. 

 
NOTE:  If you double click a menu item for titles, it will superimpose it on top of your 
video, wherever you have the playback head. 

 

Adjusting Audio  
Good audio really depends on the original production value (e.g., the microphone used).  
At most, you might need to boost the audio level so you can hear it better.  To do so, 
click on the audio line and drag. 
 

It is tradition to start and end a video by fading up from a black screen.  To do this, we 
will need the transitions menu.  From the menu tabs to the left of your Album, select 
the transitions tab.  When it opens, you will see a library of different transitions.   

 
• Open the Transitions tab.   
• Select the first transition, which is fade. 
• Left click the fade transition and drag it to the very beginning of your movie.  

When it turns green, let it go.  It will automatically place it where it needs to 
go.   

• Play it back to make sure it fades correctly.   
• Now add a fade to black transition at the very end of your movie. 
• Save your movie project. 
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Audio level 
 

 
 
 
 
 
    Point of adjustment 
 
 
 

Adjusting Audio in the Audio Track 
 
 
Commonly, video editors use the second audio track (the first one is your original 
recorded sound (see above) to add ‘music under’.  This is music used to add mood and 
should never compete with your narration.   You don’t really need a music track if you 
are simply editing VHS clips together.  Typically however, a movie creates ‘mood’ by 
including a second track of music.  This volume of this track is quieter, so it is referred to 
as ‘music under’.  You don’t want it equal volume with the narrative track or the two will 
compete.   
 

 
 
You also have the choice of connecting a microphone and narrating over your video.  
This is called a ‘voice over’ track.  It is probably best that you choose someone with a 
performance background to record the narrative. 
 
 
 
 
 
 
 
 
 

• From the Album menu, open the Music tab (looks like a musical staff).   
• Browse through your computer’s directories until you find your music track. 
• Left click the music file and drag it to the beginning of your second audio 

track.  When it turns green, let it go.  It will automatically place it where it 
needs to go.   

• Play it back to make sure it fades correctly.   
• Adjust the audio until it is low enough to be heard, but not compete with the 

narration.   
• Save your movie project. 
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Step Three:  Creating your Final Movie 
To start, click on the Make Movie tab.   You will see a horizontal menu panel, listing the 
three options:  Disc, File or Tape.  Select the one you wish to create.   
 
Disc – Allows you to create or ‘burn’ a DVD for playback on a DVD player. 
File – Creates a file. There are several file options, including .avi, mpeg. Etc. 
Tape – Use this is you wish to record your movie back to a digital video tape using a 
video camera.  You will have to connect your camera in order to do so. 
 

 
Make Movie File Options 

 
 
A review of the movie types and their associated applications is listed below. 
Final Application Preferred File Format Media Player Used 
PowerPoint on PC .avi  Windows Media Player 

(embedded in PowerPoint)* 
Play on any PC .avi or .mpeg1 Windows Media Player 
Streaming over Internet .wmv Windows Media Player 
Home DVD Player .mpeg2 DVD Equipment 
Video CD or VCD NA - Not recommended NA – Not recommended 
Tape .dv Digital Camcorder 
 
After you select your file, you need to set up your Settings.   Most video formats allow 
you to set the size of the playback window, the quality of the audio, and the resolution of 
the video.  The higher the quality, the bigger the file size.  Remember that an AVI file is 
bigger than an MPEG, but AVI is PowerPoint’s preferred file type for inserting video.  
Since video files tend to be very large, you should create a streaming video file if you 
plan to use the video on Blackboard or the Internet.  Other than that, the settings are 
highly variable depending on your specific need.  Plan to work with FCLD to help you 
find settings that will work.   
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Here are some helpful guidelines for the most common applications here: 
 
Make File → AVI – You can choose between full screen or medium.  If you are going to 
be using it with PowerPoint, try medium.  Create a short sample .avi file and test it out in 
a classroom.  Is it fuzzy?  Easy to see from the back of the room?  Adjust to full or 
medium screen as needed, then complete your movie. 

 
Settings Menu Showing AVI Options 

 
File → Stream –  Streaming files ‘trickle’ down or stream short amounts of the movie in 
one continuous stream.  This way, the person watching doesn’t have to wait for the entire   
movie file to download to his or her PC before watching it.   
 
Streaming rates refer to how much file information is streamed per second.  Actual 
streaming rates are not listed in Pinnacle Studio.  Instead, Pinnacle provides simplified 
terms such as Very High, Medium, etc.  The Medium rate is actually 240 kb/sec transfer 
rate, which is what we recommend for a good rate for both on and off campus access.  
The size of the video is listed in the settings menu.  These do not appear to be adjustable.   
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                                                         Settings Menu Showing Streaming Options 
 
If you are planning to make a DVD, you may wish to add scene markers or chapters first.   
 
Creating a Chapter Menu for a DVD 
It is possible to put a DVD Chapter menu on a movie if your final movie is going to be 
burned to a DVD.  The easiest way to do this is to click on the Menu tab, then say Yes 
when asked if you wish to create chapters at the start of each scene.  You can always 
undo if you don’t like the results. 
 
          
 
Menu Tab 

 
                                Adding Chapter Menu to your Movie 

Disc   DVD - Select Disc if you wish to burn a DVD for playback on a home DVD 
player.  Although a completed DVD can playback on virtually any home DVD player, in 
order to create a DVD, you must use the DVD format that is compatible with your 
DVD burner.   This will be DVD+R, DVD-R or DVD+-R.  Look at the burner door 
to see if it indicates which format to use.    

Pinnacle will allow you to 
create either a Windows 
Media streaming File or a 
Real Media file.   
 
Keep in mind that you 
must match the file with 
the streaming server 
available on campus.  
FCLD has access to a 
Windows Media 
streaming server, so you 
will probably want to 
choose the Windows 
Media file format.   
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In Pinnacle, use the default settings for a DVD.  Do not select S-VCD or VideoCD as 
your output; these are older formats and they will not work well.  When creating a DVD, 
remember that burning a DVD can take many hours.  Plan on starting the burning process, 
doing something else for a while, and then returning when the burning has completed.  
The finished DVD should work on most DVD players.  
 

 
Settings Menu showing DVD Options 

 
Do not assume the settings in these examples are the ‘right ones’ for your project.  Please 
consult with FCLD for assistance with your individual project and test them out first.  

Getting Help with Technology at the University of Hartford 
 
Faculty Center for Learning Development (FCLD) 
FCLD provides consulting and support to faculty and staff who are using technology in 
instruction.   
Phone: 768-4253   Email: fcld@hartford.edu Website: http://uhaweb.hartford.edu/fcld 

Information Technology Services (ITS)   
ITS Help Desk – Computing Center 
For general computer and Internet/network support questions. 
Phone: 768-5999  Email: its@hartford.edu Website: http://uhaweb.hartford.edu/its/ 
 
Media Technology Services (MTS) – Harry Jack Gray Center 111A 
Faculty should contact MTS for assistance scheduling classroom technology. 
Phone: 768-4643 (Main) or 768-4662 (Tech Line)   Website: www.hartford.edu/mts   


